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Chapter 4: Configuring the ERM And Slave Modules with ERM Workbench

ERM Workbench Software

Ethernet Remote Master (ERM) Workbench is a software utility that must be used to
configure the ERM and its remote Ethernet slaves. The ERM Workbench supports two
methods of configuring the ERM I/O network. Both methods are explained later in this

chapter.

The two configuration methods are:
* ERM Workbench PLC Wizard — simplifies the ERM I/O network configuration procedure when a

PLC is used as the CPU Interface.

* ERM Workbench — configures an ERM I/O network whether the CPU Interface is a PLC or
WinPLC, and allows access to all ERM I/O network parameters.

NetEdit, a software utility within ERM Workbench, can be used to set the Ethernet

master/slave Module ID, set an IP address if necessary or configure 405 EBCs with analog

1/0O modules. Both ERM Workbench and NetEdit can be used to monitor the remote I/O

network and to perform diagnostic and troubleshooting tasks.

ERM Workbench software is installed as a utility program when you install DirectSOFT or
Do-more Designer. The latest version of ERM Workbench is also available for download from
Host Engineering’s web site (www.hosteng.com). ERM Workbench consists of several files, all
of which must be located in the same directory. The installation process places the files in the
C:\HAPTools directory (default). The files may be placed in another directory, but remember
all of the ERM Workbench files must be placed within the same directory.

Launching ERM Workbench
There are four methods to launch ERM Workbench:

e using the Windows Start menu
Programs>AutomationDirect Tools>ERM Workbench

(on right)

Fle View Help

g DirectSOFT on the Web

Applcations _ * launching DirectSOFT, then select PLC
@ DirectSOFT 5 Programming >TOOIS>ERM WOIkbCIlCh

Eﬁ Utilities

Visit AutomationDirect . .
ﬂ Vit Host Engheering ¢ launching DirectSOFT, then select

] Host Forum, FAGs, Downloads. . UtilitiessERM Workbench (on left)
CTRIO WE 2 - DirectLogic PLC
CTRIQ WE 2 - EBC + WinPLC
CTRIO WE 2 - PEC
- [HR] CTRIO WE 2 - Offiine

B FERM Workbench

.. [83] DBWin32 Logger

- [EM oMLoader Applications:
"% Do-mare Designer DB'."-a'in32 I

& NetEdit 3
-] Caleulator
| Version
{7 oss0n.ini

J Visit AutomationDirect déNetEdit 3

|__| Visit Host Engineering =] Caleulator
|_|Host Forum, FAQs, Downloads... 4 Do-more &

CTRIO WE 2 - Do-more PLC Do-more L . .
] CTRIO W 2 - Offine Bpomarev || © launching Do-more Designer, then

ERM Warkbench DmDesigr select ERM Workbench from the
B Launchpad (on left)
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L

Adding IPX Network Protocol Support on PCs with Windows XP (32 bit only)

or Earlier Operating Systems
You may have already set up your PC with selected networking protocols for Ethernet
communications. If not, you will need to select the protocols now for communication with
the ERM module. We strongly recommend that you include the IPX protocol. The
description below applies to Windows 2000 (Windows 98/NT/XP have slightly different
steps). If you are not familiar with this procedure, you may need to have your Network
Administrator perform this task.

Double click on Network and Dial-up Connections, then double click on the desired
Network Device to see the installed Protocols. If IPX is not listed among the protocols already
loaded, add it now by clicking on the Install button. For Windows XD, go from
Start>Settings>Control Panel. The steps are the same as Windows 2000 from this point.

n For Windows 2000, go from My Computer on your Windows desktop to Control Panel.

Add the TCP/IP protocol if it is necessary for your application. The TCP/IP selection will
give you support for the UDP/IP protocol. Also, add the IPX protocol if it is not already
active.

Network Properties 7 2l x|
General 1 Sharing]
Conmect using

| 3 Realtek RTL8139(4}based PCI Fast Ethernet Adapter

Components checked are used by this connection:

¥l %2, File: and Printer Sharing for Micrasoft Networks
¥~ NwLink NetBIOS

1™ WwLink IPX/SP/NetBl 05 Compatible Trarsport Proto
\4"‘?{_ Internet Protacal [TCPAP]
4

L\LLI;

| »

Install.. |

Deescription

™ Show icon in taskbar when connected

0K Cancel

NOTE: We strongly recommend you load IPX protocol on your PC for the connectionfrom your PC to the
ethernet modules. Use UDP/IP in your application, if required,but also add IPX to your list of active
protocols. Having IPX loaded on your PC gives you a backup for troubleshooting communication problems.
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Running ERM Workbench PLC Wizard

Run ERM Workbench PLC Wizard by launching DirectSOFT or Do-more Designer, then
select ERM Workbench as mentioned on the prevous page. The Wizard allows the ERM
network to be easily and completely configured without having to use the more advanced

ERM Workbench utility.

NOTE: The ERM module and ERM Workbench utility factory default settings are located in Appendix C.
These defaults will be applied during the ERM network configuration unless otherwise changed. Some of

the settings can be changed within the ERM PLC Wizard, but all can be changed using the ERM
Workbench utility.

Step 1: Choosing the ERM Network Configuration

Select either Hub or Point—to—point to describe the ERM network system that will be used.
This example assumes that a Hub network is used. Once a selection has been made, click on
the Next button.

ERM Workbench PLC Wizard - Step 1: Describe ERM/Slave Network |

To help configure the ERMin & PLC system, please choose the description below that best describes this ERM/slave
network configuration, then hit the Next-> buttan

ERM Network C

% Hub - one ERM and one or more slaves are connected to each other using an Ethemet hub

¢~ Point-to-poirt - one ERM and exactly one slave are dirctly connected to each other using a cross over cable
without @ hub

I~ Please, do NOT launch PLC Wizard at startup

ERM Workbench < Back Cancel

Step 2: Connecting the ERM Workbench PC to the ERM Network

Connect the ERM Workbench PC to the dedicated ERM network hub. If only one slave is
used, connect the PC directly to that slave. Then click on the Next button.

ERM Workbench PLC Wizard - Step 1: Describe ERM/Slave Network |

To help configure the ERM in & PLC system, please choose the description below that best describes this ERM/slave
network corfiguration, then hit the Next-> button

ERM Network Configuration

* Hub - one ERM and one or more slaves are connected to each other using an Ethemet hub

¢~ Point-to-poirt - one ERM and exactly one slave are dirctly connected to each other using a cross over cable
without @ hub

I~ Please, do NOT launch PLC Wizard at startup

ERM Workbench.. < Bk Cancel
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m
Establishing Communication with the ERM

The following window will be displayed if an ERM module is found on the network. Click
on the Flash Error Light button to confirm that the correct ERM module has been found
(the ERM’s LED will flash for 3 seconds). If the PC is connected directly to the slave in a
Point—to—point network, this window will not be displayed until the PC is connected directly
to the ERM module.

Ethernet Remote Master Fo x|

Ethemet Remote b aster found at the following address:

Ethemet Addrezs: | O0EOEZ 21 B3BY
with IP Address: | 172, 30, 58. 78

Ta wizually check which ERM was found, click on the
Flazh Error Light button below to flazh the ERM module's
ERROR light off & on for 3 seconds.

oK | Cancel | Flash Error Light

Step 3: Select and Configure the Slaves
The Select and Configure Slaves window will display all of the slaves found on the dedicated
ERM network. The order of how the I/O is mapped into the PLC is based on the slave order.
The ERM to Slave Address Mode selection determines the address mode in which the ERM
module will use to communicate with its slaves. Chapter 2 describes the ERM / Slave
Addressing Modes. Click on the Next button once the slave list is configured.

e =13l

Fils Wew Help

DESE masd WS E T

ERM Workbench PLC Wizard - Step 3: Select and Configure Slaves I x|

ERM to Slave Address Mode y ot o possble o
= o1z is 3 list of possible slaves.

’V @ EthemetAddiess ¢ ModuelD € IPAddress ot et ehangs the
; ; arder of the slaves. The order

Disciete  Discrete  Anabg  Aralog S 10 o et

Input DOutput Input Output the PLC is based off the slave
Pairts Pairts ‘wiords

‘wiords order.

ou can corfigure the address
mode sed by the ERM when
addiessing the slaves. You
can alsa temove any unwanted
slaves from the list

Oncs you have the slave list
conligured, ht the Next buttan.

Move Up MoveDown | Femove | Resean |

ERM Workbench. < Back Cancel

NOTE: Due to the manner in which 1/0 is grouped into PLC addresses, it is advisable, for future expansion
purposes, to pad the base with extra I/0. The wizard does not offer the option to add unused addresses. To
pad the addresses, add extra I/0 before running the wizard. If the padding is not created, adding an /0
module to the base in the future will offset a wide range of I/0 in the PLC’s memory map.

4-6 I Ethernet Remote Master User Manual, 2nd Edition, Rev. A - H24-ERM-M



Chapter 4: Configuring the ERM And Slave Modules with ERM Workbench

i

Step 4: Map 1/O to PLC Memory
Select the starting PLC memory addresses for each of the four I/O types: Discrete Inputs,
Discrete Outputs, Analog Inputs and Analog Outputs. Be sure that the selected starting
addresses do not conflict with any local I/O or any memory locations used in the ladder logic
program. Note that the first two words of memory in the Discrete Input table is reserved for
ERM status information and the first word of memory in the Discrete Output table is
reserved for Disable Slave Command bits. For more detailed information on PLC I/O
mapping, refer to the “PLC Map” section on page 4-10 and the “Reserved PLC Memory for
ERM?” section on page 4—15. Click on the Next button once the starting PLC addresses have
been selected.

DirectLOGIC ERM Workbench PLC Wizard - Step 4: Map 1/0 to PLC Memory x|
PLE Map
StatingPLC  ErdingPLC  StatingERM  Stetting Discrste Erding Discrete
Yaddwss  Waddmss  Statushddiess 140 Address 170 Aclhess
Discrele + [EEEET Al
e [EAE EI [vanatz [ vanaia(xan) | vaons(xan] | vaoa7(xa67)

Diserete Y
Phorcte v[innie $] [vaosis | vaosi v | vamsISEa0 | 4SIe (a7 )

Analog Al
s, V00 %] v
PLC Memory hap.
Analog vy 2100 &
Outputs: EI a1l

How select the starting PLE addresses for sach of the four data types - Discrete Inputs, Discrete Outputs,
Analag Inputs and Analog Dutputs. We recommend you utize the X and ' mapped areas of Y memorp for
vour discrete inputs and discrete outputs.

Note that the first bwo words of % memory in the Discrete Input table is for ERM status information, and the first
wiord of ¥ memory in the Discrete Dutput bable is for Disable Slave Command bits

ERM Workberch <Back Cancel
Do-more ERM Workbench PLC Wizard - Step 4: Map 1/0 to PLC Memory: x|

PLC Map

Stating Domore Ending PLC ~ Statng ERM  Statting Discrete  Ending Discrete
c VAddess  Stafus Address 1/0 Address 1/0 Address

Eﬁ:ﬁ: I??’D_m§]| wa | x| none \
Gy oy [0 &l we [ o [ oene \
ﬁ:?sg DLV Wi’m PLC Memory Map.
omes o #[ e

Now select the starting PLC addresses for each of the four data types - Discrete Inputs, Discrete Outputs, Analog Inputs
and Analog Outputs. We recommend you wtilze the X and Y mapped areas of V memory for your discrete inputs and
discrete outputs

Note that the first two words (32 bits) in the Discrete Input table is for ERM status information, and the first word (16 bits)in
the Discrete Output tabie is for Disable Slave Command bits:

ERM Workbench < Back Cancel

Step 5: Download Configuration to ERM

The following window displays how the slave I/O will be mapped into the PLC memory. The
network I/0 modules and I/O points are listed by slave and slot number. This configuration
is written to the ERM by clicking on the “Write to ERM” button. If any advanced
configuration needs to be done, click on the ERM Workbench button. The modified
configuration can then be downloaded from the ERM Workbench utility to the ERM
module.
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ER™M Workbench PLC Wizard - Step 5: Configuration Complete - Download or Do x|

Congratulations! ‘Yo have buik you Ethemet Rremate Master configuration, Belaw is the list of al the slkaves
and how their 140 is mapped inta PLC memary

If you wish to download the configuration ta the ERM immediately, hit the wiite To ERM button below

O, if you wish to do some advanced configuration without downloading, select the ERM “w/orkbench button
‘rou can then download the configuration from the ERM “wrkbench utility,

1/0 Module | 110 Points: [ PLC Start [ PLC End [ ¥-Map [ Notes -
<aeserveds Slave Stalus Bils RO AT w4414
ERM Status WwWord =320 ®337 40415
Digable Slave Com. 300 W37 V40514
Slave 1 H2EBC Ethernet &ddress[0C
Slave 1/5lot 0 16 Discrete Input R340 M3ET V4416
Slave1/5lot 1 8 Disorete Output V320 Y327 V40515 Lo[07)
Slave 1/500t 2 4 Word Input V2000 w2003 16+t Binary;
2 ord Output w2100 vzio 16+t Binary,
Slave 2 TIH-EBC hotswap{auta) Ether
Slave 2/5It 1 B Discrete Input ®IBO M7 V40417 Lo[DT)
Slave2/Slt2  BDoubleword Du. V2102 w2121 320t Binany: -
8 Discrete Output Y330 Y3IF V40515 HilB15)
Slave2/SIt3  8Double'wodIrput V2004 w2023 320t Binany; =
4| | 3

ERM warkbench < Back I “Wiite To ERM I Cancel

ERM Workbench Main Configuration Window
The ERM Workbench main configuration window will be displayed once the configuration is
written to the ERM. Refer to the “Write Configuration to ERM” section on page 4-14 for a
complete description of the window fields.

In the Slave Status box, the status of a specific slave can be displayed by clicking on the slave
number 1-16. The numbers are highlighted in either normal, green, yellow or red. Normal
(default) indicates that the slave is not configured. Green indicates the ERM is successfully
communicating with that particular slave. Yellow indicates I/O is being updating, but some
error exists within the I/O of that slave (i.e. module missing 24VDC, unused analog channels
exist, broken transmitter or module missing terminal block, etc.). Red indicates I/O is not
being updating and that the ERM is not communicating with that slave. Clicking on the
Slave’s Error List button will display the error conditions for that particular slave. The error
codes are then defined under the Error List button.

&5 ERM Module [00 E0 62 20 13 E2] - ERM Workbench | =10 x|

File View Help

EEE Y TR

- Ethemet Fiemate Master | HZERM — Ethemet Addhess:| DOENE22013E2 —IP:| 255 255 255 265 —Module I 0
Inkerface: : [T B3 [4 [5 [5 [7 [8 EY——
LastERM no enor PLCHode: [ Pogen | o~ o 7 [z (3 94 5 (6
e 3. Wite ta ERM...
Click on slave # above Slave 2 - no errar —
o to see its Last Eror
Bead ER Status [ | == ST] 10:40:31
Clear Last Enor Slave 2 | Slave ZsEnorList |
Detailed EAM Status.
140 Madule 1170 Proints [ PLCStat| PLCEnd|WMap | Wotes [
<reserved> Slave Status Bits 300 W37 VADATE
ERM Status Word %320 X3 VA041G
Disable Slave Comm. 300 YIT vA0ST4
Slave 1 HZ-EBC Ethemet Address[00 E0 62 00 01 D4] on IP%;
Slave 1/5iot 0 16 Discrete Input %340 %357 V40416
Slave 17500t 1 8 Digcrete Qutput 320 Y327 Va6,
Slave 151012 4word Input Y2000 w2003 16-bit Binary:
2 Word Dutput vzion w21 16-bit Binany:
Slave 2 TIHEBC hotswap(auta] Ethernet Address[00 E0 62 40 05 34] on IPX;
Slave 2/5iot 1 8 Discrete Input 5360 %IE7 VAOHTT
Slawe 2/50t 2 8 Double word Output w210z Y2121 32-bit Binary:
8 Discrete Output ¥330 Y3 VAOGIS..
Slave 25101 3 8 Double Word Input Y2004 Y2023 32bit Binary:
4DoubleWword Dutput V2122 w2131 32-bit Binary:
8 Discrete Dutput 340 Y347 VAOSTB
Ready [ | ReadERMStatus: AUTO  |MODIFIED | [nUM | A
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Running ERM Workbench

First, run the ERM Workbench PLC Wizard by launching DirectSOFT or Do-more
Designer, then select ERM Workbench as previously mentioned in the Launching ERM
Workbench Section. With the wizard opened, click the ERM Workbench button in the lower
left hand side of the ERM Workbench PLC Wizard window. Checking the “Please do Not
Launch PLC Wizard at startup” box will disable the Wizard from launching, but can be
accessed from View menu>PLC Wizard. The following window will be displayed.

' ERM Module [00 E0 62 20 13 E2] - ERM Workbench R | -|al x|

File Wiew Help

DSH end ik S E 7

i~ Ethernet Remote Maslev*l HZ-ERM — Ethemet Addless‘{ ODEOR22013E2 *\P'l 255.255.256.255 —Modulz 100 0

1. Cortigure ERM
FLC cPU; [ 280 Save Stat

Al s s[5 [s [7 I8 YT e —
5 [o [T [z @@ @ 05 66 —

Click on slave # above | Slave 1-not configured
S to see its Last Error:
Bead ERM Status M8 o |4 0.48:20

last read:

Clear Last Enor Slave 1 | Slave s EnarList |
Detailed ERM Status

Interface: ‘

Last ER | Misting configuiation  PLC Mode: | Program

Eror:

1/0 Madule [ 170 Paiints | PLCStat[ PLCEnd[ W-Map [ Nates [
n/a nia nia nfa nia ERM NOT CONFIGURED
<resemved> Slavs Status Bits %00 K37 VA4S

ERM Status Ward X0 KIW V441G

Disable Slave Comm.. VA0 Y37 V40514

Connecting the ERM Workbench PC to the Network Modules
The ERM Workbench PC will need to be connected to the ERM network to configure the
modules as described in this chapter. A hub is not necessary if only one network slave is used.
In this case, the PC will need to be connected directly to the slave module to configure the
slave. Then, the PC will need to be connected directly to the ERM module to configure the

ERM. Strid
ride
ERM
Ethernet Do-more PLC
| (el [

DirectlLogic
DL205 I/O with
EBC Module

Directlogic
DL405 1/0 with
EBC Module

Terminator I/O
with EBC Module
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.Configure the ERM

NOTE: The ERM module and ERM Workbench utility factory default settings are located in Appendix C.
These defaults will be applied during the ERM network configuration unless otherwise changed. The default
settings can be changed during configuration, module by module, within the ERM Workbench. Also, the
ERM Workbench> View menu>0Options allows the default settings to be change at a system level that will
apply to all the new module configurations.

Configuring the ERM

Click on “1. Configure ERM”

button. Then select either Direct LOGIC PLC, Do-more PLC

or WinPLC as the ERM / CPU Interface.

il =10l x|
DERE e f S E?
Etheret Remote Master Etheret Adhess: P Madule 1D
U fave Status
Inteface Tz s [4 [5 [e [7 [8 2 Select Slaves
Lasga B
Eror 2. Wite to ERM...
ERM/CPU Intetface: (1ot Corfigured =
Cancel
Advanced. |
140 Mokl
<reserveds
Mot that the st 2 WORIDs (32 bits] i the Dissrsts Inpul tables is for ERM status information,
s the fist WIRD [16 bits) in the Discrsts DLpUL tshle i for Dissble Slave Command bits
Ready MODIFIED NUM
1
Selecting PLC as Interface =~ EED -
. . ERM/CPU Interface: |[Sffe
If either PLC is selected, the
N PLC Map Cancel
PLC Map is enabled. If VI S Summpee
\x]inPLC is selected, th€ PLC D,‘i‘;'j’: V40404 §| VADA04 [X100) | Y4DA0G (%140 Advanced...
Map Wlll remain disabled. gﬁ:’;‘: v |40504 §| VADS04[¥100) | V40505 [120]
The PLC Map 1S explalned mﬂu‘fsg v [T00 il I
M M lemory May
on the next page. Clickingon | ..., em [FEEEEE|
putpus =
the PLC Memory Map = 2]
. . Mote that the first 2'w/ORDs [32 bits] in the E——
button displays the valid e D e e e EFM o T
PLC M Cancel
memory ranges for each PLC e — Stalng BRI Statig Disciels
) - Statushddress 1D Address
that supports the ERM D;f‘:ﬁf o x| [100 §| DL100 DLX140 Advanced
Discrete - a
module. Dﬁ;’j: DLY 100 il DLY100 DLY120
‘Anallug DLy 100 §|
e PLE Memory Map.
Anal i
=4

4-10 |

Mate that the first 2 WORDs (32 bits] in the Discrete Input table is for ERM status information,
and the first WORD (16 bits] in the Discrete Output table is for Disable Slawe Command bits.
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i
PLC Map
A starting PLC memory address must be specified for each of the four types of I/O. The
ending address for each I/O type is determined by the amount of each I/O type used by the
slaves. The PLC Map is divided into 4 separate tables.

1. Discrete Inputs: This is where the ERM will Write all of the slaves’ Discrete Input data.

2. Discrete Outputs: The ERM will Read this from the PLC and Write it to the slaves
Discrete Outputs.

3. Analog Inputs: This is where the ERM will Write all of the slaves” Analog Input data.

4. Analog Outputs: The ERM will Read this from the PLC and Write it to the slaves Analog
Outputs.

It is recommended to use the V404xx or DLX3xx (X’s) for Discrete inputs and V405xx or
DLY3xx (Y’s) for Discrete Outputs that are beyond the expansion base I/O that exists. The
default addresses are V40414 (X300) and V40514 (Y300) for Direct LOGIC users and
DLX300 and DLY300 for Do-more users. Note that the Starting PLC address and the
Starting Discrete I/O Address are not the same. The first two words of memory in the
Discrete Input table is used for ERM/slave status information, and the first word of memory
in the Discrete Output table is for Disable Slave Command bits. Adjust these address as
needed, but do not map over local I/0 used and be sure the PLC supports the alternate
addresses selected.

Advanced ERM Configuration
Clicking on the ERM Configuration “Advance” button displays the following window.

G ~loix
DEE e d WP &3 E2

Ethemet Remote Master Ethemet Addiess: 1P: Module 1D
1. Configur ERM.
cRU . Sleve Stalus
|
Standby Cycle Time PLC Scan Timeout
Time to wait when a slave i ol responding before tying to access the Time for ERM to wait o the PLC when the PLE is ot respornding due to
slave again Jong PLE scan s
IF DISABLED, ERM willy to commuricate with slave every |/ cpole, I | It recommended you set this bo at Ieasttrice Hhe ki PLT scan
ENABLED, ERM will 1y 0 communicats ot the given ineral time for your program. Diefaul (and mirimu) i 100 s,
Enable Stanchy  [55 Al Al
2 el £ 2w
Unsupported Slave Cycle Time Advanced ERM Network Settings
Time to wait when a lave is not supported before trying to access the \Warting! If you are ot famiiar with these Advanced Network sefiings,
sl again, 4 sleve i not supparted whe i 40 Canliguration doss not | please leave them disabled, or cornsultyout nehwcrk administrator,
match ERM's or the slave's frmmare is absclete, S B UID Bt
IF DISAELED, ERM will nat commuricats with stave untl ERM is power
cyclad, wher suppor wil bs checked sgsin. 1t ENABLED, ERM wil
check sheve suppor ot given nterval,  sleve is then supperted, slave wil
be included in EF's 120 cycle
Enable Unsupported Y
M Slave Cycie Time |1000 i‘ ms

Ready MODIFIED NUM

Standby Cycle Time is the time the ERM will wait before trying to communicate with a slave
that had a communication error. Enabling this feature will help overall I/O throughput when
one slave errors in a multi-slave network. If the Standby Cycle Time is disabled, the ERM
will try to communicate with the slave in error every 1/O cycle. If enabled, the ERM will try
to communicate with the slave in error at the given time interval.
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[ |
PLC Scan Timeout is the time for the ERM to wait on the PLC when the PLC is not

responding due to long PLC scan times. It is recommended to keep it at the default of 100ms
or twice the maximum PLC scan time, whichever is greater.

Unsupported Slave Cycle Time is the time the ERM will wait before trying to communicate
with a slave that cannot be supported by the ERM. An unsupported slave may have an I/0
configuration that does not match the ERM’s or may have obsolete firmware. If disabled, the
ERM will not try to communicate with the unsupported slave again until ERM power is
cycled. If enabled, the ERM will check slave support at the given time interval. If the slave is
then supported, the slave will be included in the ERM’s I/O cycle.

Advanced ERM Network Settings are used to configure the ERM’s UDP/IP subnet mask for
IP address handling. Consult your network administrator if needed.

Select the Slaves

Selecting the Slaves
Select “2. Select Slaves” button. In order to select and configure the slaves, the PC running
ERM Workbench needs to be connected to the specific remote Ethernet slave network.

NOTE: A Think & Do WinPLC can only support one slave per ERM module. A PLC can support up to
— sixteen slaves per ERM modules.

© ®

Select Slaves x|
FIRST, select the slaves to be controllsd by ths Etheme! Flemote  [SECOND, configure dach slave. Defautcan | © /@ Configuration
Master. U ta 16 slaves can be added to an ERM's slave st werk, but adjustmehits may be necessay.
S Local HZEBC
PL Network Slaves o (™ & UDP/IP ERM's Slave List COED 2 T T
/ Module  bladel Frotocat | PR

Etheinet Address IP Address 10 Mumber #  Slave Stalus rotoca!

00ED 62001311 255 %5 5 00 E0620019 11 [Local Ethemet Addiess
@ Address bode: | g1 EQE2 001911

ERM Timeout

2

3

4 wSlave | 2

g Reties: | 1

a Faihues Before [

q Standhy Mode:

/ 10 Watchdog [ 557
11 Timaout:

g PetFrequency: | 125

14 101 Count
15 Discrete
16 Inputs:

Diserete 000e ™ points

Outputs
Ltz none words

Inputs

none  points

Showin List Riemove Fiemave Al Dﬂmf none werds
@ SlavesOrly O ERMsOnly € AlDevices
Corfigurs
Query P Addto
Netunik WeEdt Slave List > Cancel

[

@ & @
A. In the upper left corner of the Select Slaves window is a “PC Network Slaves on Protocol
Group List”. Clicking on either the IPX or UDP/IP radio button determines which
protocol is used by the PC running ERM Workbench to communicate with the remote

master and slave modules. The ERM and its slave modules understand either protocol.
Only one of the protocols needs to be installed on the PC to configure the ERM.

B. The left column displays the Ethernet Address, IP Address, Module ID and Model number
of the slaves currently on the remote I/O network. If slaves are added or removed from the
network, click on the Query Network button (1) to update the list.
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C. The center column displays the ERM’s Slave List. To add a slave to the ERM’s List, either

double click on a slave in the PC Network Slave List or select the slave and click on the
Add to Slave List button (2). Slaves can also be removed from the ERM’s List by clicking
on the Remove button. One ERM can support up to 16 remote slaves.

D. The right column displays the Slave Configuration of the slave that is selected in the
ERM’s Slave List.

E. NetEdit can be used to assign IP Addresses to the remote I/O network modules if required.
NetEdit is also required if Module ID is to be software set or if the 405 EBC is used with
analog I/0 modules. Normally, a network administrator will assign an IP Address to each
module on the network. Since it is recommended to use a dedicated remote I/O network,
it is not necessary to assign IP Address unless the UDP/IP protocol must be used. Refer to
Chapter 4 “Using NetEdit” for more information.

Configure the Slaves

Setting the Slave’s Parameters
Remote slave parameters (protocol, address mode, timeout, etc.) are set individually for each
slave. To configure a slave, select a specific slave in the ERM’s Slave List by either double
clicking on that slave or by clicking on the “Configure” button once the slave is highlighted.
The following window will display the settings of the selected slave module.

Configure Slave [H2-EBC- 00 E0 6200 19 11] ﬂ
@ ——ERM to Slave Communication Setlings Watchdog Seliings

Protacol Enabling the watchdog empawers the slave to tuim off all outputs when the slave

na longer receives any |/0 requests fiom the Ethemet Fiemote Master madule
&R UDPAR after the speciied meaut period. If enabled, st the watchda fimer to AT
LEAST 10 millsesonds

Advanced IPX.. Disabling the slave's watchdog timer will cause all of the slave's outputs to remain
in theit |ast state indsfinitely

Hetwork Number. 0 Enable Slave's P
M ‘Walchdag Timeout: 50 i‘ (5
EFM Pet Frequency

If the watchdog timer is enabled for this slave, the ERM can be enabled to
pet this slave to keep this slave's watchdog timer from firing,

Address Modg" Make Offine This may be important when the main CPL has inconsistent lagic times or

the ERM has inconsistent |0 cpcle times with other slaves.

j Set the pet fiequency to AT MOST half the watchdog fimeout valus, ahd
AT LEAST 5 miliseconds.
® ¢ lEi‘E’FAlddﬁ“f =] W EntioPetevery: [125 2] s

&
|_ |_ |_ |_ Reserve PLE Addresses for Expansion \
erve

Since 140 for muliple slaves is packed into PLE memory, us padding to res

room for future 120 in this slave. Az /0 is added or removed, adiust the pad
ERM Timeout to ’257 i‘ values accordingly so that PLC addresses of ather slaves' 1/0 can remain at the

Slave Response: ms same PLC address
— ) 7S Discrets A BYTES . 7
@ Revies:[1 2] il e fnaba [0 2| woRDS

Conseculive Fallies a Discrete [T 4| BYTES g [T A
Before StandBy Mode: | i‘ Duputs: (8 per byte) Ouiputs: :I WORDS

i SetDefaut | Advanced . | Cancel |

A. The left column, ERM to Slave Communication Settings, determines the protocol, address
mode and the communication Timeout Settings the ERM module will use to
communicate with the specific slave selected.

B. In the Protocol box, click on either the IPX or UDP/IP radio button to select which
protocol the ERM will use to communicate with the selected slave. If UDP/IP protocol is
selected, a valid IP address must be assigned using NetEdit. The Address Mode determines
which network identifier will be used by the ERM to address the selected slave. IPX
protocol supports either Module ID or Ethernet Address. UDP/IP protocol supports only
IP Addressing.
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C. ERM Timeout to Slave Response, Retries and Consecutive Failures Before Standby Mode

times can be set for each slave. The default time values should be adequate for most
applications. The values may need to be raised in applications where IP addressing and
routers are used or if a dedicated remote I/O network is not used.

D. Enabling the Slave’s Watchdog Timeout runs in the slave and allows the slave to turn off
all outputs when the slave no longer receives any 1/0 requests from the ERM module.
Any outputs that were on at the time of the error will turn off after the specified time
elapses. Set the ERM Pet Frequency runs in the ERM to reset the watchdog timer in the
slave to avoid any nuisance timeouts due to main CPU inconsistent logic times or ERM

/O cycle times. Disabling the the slave’s WatchDog timer will cause all of the outputs to
remain in their last state indefinitely (hold) when the slave no longer receives any I/O
requests.

E. Reserve PLC Addresses for Expansion allows future I/O modules to be added or existing
modules to be removed from a slave without affecting the PLC addresses of the other slaves
on the network. Pad the discrete inputs and outputs using bytes (8 points per byte) and the
analog 1/O using words (2 bytes). Padding can only be done for I/O at the end of a slave
I/0O base, not between two I/O modules on the slave.

E The Make Offline Feature may be useful for users or OEMs that require duplicating a
system several times. For example, a system may consist of 3 EBCs. An offline ERM
configuration allows each additional ERM to be configured without actually connecting its
slaves at configuration time. Once the initial ERM system is configured, its ERM
Workbench configuration file can be used to create another configuration file with different
slave addresses. Checking the Make Offline checkbox allows slave addresses to be manually
set that should be used by the ERM. This does not change the address in the slave, but
changes the ERM configuration to address a different slave without connecting it on the
network when configuring the ERM.

Once the CPU Interface and Slaves have been selected and configured, the network I/O
modules and 1/O points will be listed by slave and slot number as shown on the next page
(A.). The next step will be to write the configuration to the ERM module.
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Write Configuration to ERM

After the ERM CPU interface has been selected and the slaves have been configured, click on
the “3. Write to ERM” button to write the configuration information to the ERM module.
Once the download is complete, the following window can be used to check slave status and
view detailed ERM status, etc.

i1 ERM Module [00 EO 62 20 13 E2] - ERM Workbench I > (=[5}
e File View Help
Desdeaxd b 8807
Ethemet Remole Master | H2ERM — Ethemet Address| 00E0522013E2 —IP| 255.255.255.255 —Module ID:| 0
@ & Slave Stals: 1. Canfigure ERM...
T e PLC CPU: [ 260
Inteiface: I T MM s [+ [5 [8 [7 [8 2. Select Slaves.
Last ERM o erton ode: | Program T [ [T [ &
Eror 3. Wiite to ERM
Click o slave B above Slave 2- o enot

® _— to see s Last Error
— me o
F— e o [ 10.4031
Dot £ Clear Last Enror Slave 2 ‘ Slave 2 Error List |
Detaile alus...
140 Module: |10 Points [ PLCStat | PLCEnd[ ¥Map | Notes
Geserved> Slave Stalus Bils R0 REN7 D4
L~ ERM Stalus Word R ORI VADAE

®7

Slave 1

Slave 1/5lot 0
Slave 1/5lot 1
Slave 1/5lot 2

Disable Slave Comm,

16 Discrete Input
& Discrete Dutput
4w/ord Input

Yaon YIT W40ET4

KT Y40416

Ethemet Address[00 E0 62 00 01 D4] on [P

Y327 W40EIS..

16-bit Binary;

2'%/ord Output w2100 waio 1E-bit Binary:
Slave 2 TIHEBC hotswap(autalEthemet Address(00 E0 62 40 06 34] on P
Slave 2/5lat 1 & Diserete Input X360 HIET V40417,
Slave 2/5lat 2 & Double Word Output w2102 W2121 32-hit Binary;
8 Diserete Output Yaan Y337 4IRS
Slave 2/5lot 3 8 Double Word Input W04 o023 32-bit Binary;
4 Double \Word Output V2122 Rkl 32:bit Binary:

8 Discrete Output a4 Y347 W40E1E.

Ready Read ERM Status : AUTO | MODIFIED HUM

A. Once the CPU Interface and Slaves have been configured using the steps on the previous
pages, the network I/O modules and I/O points will be listed by slave and slot number.
This configuration will be written to the ERM by clicking on the “3. Write to ERM”
button. If using a PLC CPU as the interface, note that the Starting PLC address and the
Starting Discrete I/O Address are not the same. The first two words of memory in the
Discrete Input table is reserved for ERM/slave status information, and the first word of
memory in the Discrete Output table is reserved for Disable Slave Command bits. The
PLC memory map information is not displayed if a WinPLC is selected as the CPU
interface. See the following section “Reserved PLC Memory for ERM” for detailed
information. This table can be sorted by I/O module address or PLC Memory Address.

B. The top row lists the ERM’s Ethernet Address, IP Address and Module ID. It is highly
recommended that the Ethernet Address of the modules is place on a label near the
module in a visible location.

C. The PLC CPU or WinPLC Interface information is listed.

D. In the Slave Status box, the status of a specific slave can be displayed by clicking on the
slave number 1-16. The numbers are highlighted in either normal, green, yellow or red.
Normal (default) indicates that the slave is not configured. Green indicates the ERM is
successfully communicating with that particular slave. Yellow indicates I/O is being
updating, but some error exists within the I/O of that slave (i.e. module missing 24VDC,
unused analog channels exist, broken transmitter or module missing terminal block, etc.).
Red indicates I/O is not being updating and that the ERM is not communicating with
that slave. Clicking on the Slave’s Error List button will display the error conditions for
that particular slave. The error codes are then defined under the Error List button.
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E. When the CPU Interface is in the Run Mode, the “Read ERM Status” button will be
highlighted. Each time the button is clicked, the most current ERM Status information
will be read and displayed.
E “Detailed ERM Status” provides status x|
of the module including ERM 1/0 P e FLC M0 5 s
Cycle Times. This is the time required S e— e 0w e St
for the ERM module to update all of Lot A o o Gy | 0
its I/O points. Remember the ERM i me
and the PLC CPU operate e | 0 Time of Lot Fead
asynchronously from one another. The [ P T e
PLC CPU scan will be faster than the PLC Reed [ AT 2 e
ERM I/O Cycle Time. Thus, the e A e
Retries:
remote I/O points will not be updated o
every PLC CPU scan. ERM State: | 8 Format | 1
Analog 1/0 Data Registers
Analog I/0 Data Registers

Analog input data is mapped channel by channel in decimal format (binary) into consecutive
memory locations when used in an EBC base. Each individual analog I/O channel has its

own 16-bit memory location. For examp

le, an 8 channel analog input module with starting

DirectLOGIC PLC V memory address of V2000 would map the 8 channels of analog data

into V2000 — V2007, respectively.

Analog output data needs to be in decimal format (binary). For DirectLOGIC users, be sure

to convert any BCD values to decimal be

fore sending the data to the analog output registers.

Refer to the Analog I/O Manuals for conversion examples. Terminator analog I/O modules
consume two (Double) words per channel (32-bits). See Appendix E for configuring
Terminator I/O analog output module control byte.

The EBC slave modules automatically maps the analog I/O data in/out of memory, thus
multiplexing ladder logic or pointer method is not necessary.

in ERM Module [00 ED 62 20 13 E2] - ERM Workbench 3 (O] x|
Flle View Help
DEEend S B2
Etheret Remote Master | H2ERM — Ethemet Address]| D0E0E22013E2 —IP: 255.255.255.255 —Module ID:| 0
- Slave St 1. Configurs ERM
I PLC CRU: [ 280
nleiface: 3 [ 5 e [T I8
2 Select Slaves:
Last EAM o siror PLE Mode: | Program 5 [fm [T @l fE & el 6
Error 3 Wite to ERM
Ciick on slave # above Slave 2 -no sirar
to see it Last Ermor.
g Time of (04031
last read)
Clear Last Error Slave 2 | Slave 2 Error List ‘
Detaled ERM Status.
140 Module: [ 10 Paints PLC Start | PLCEnd [ WMap | Notes |
<reserveds Slave Staus Bits WA %37 VOIS
ERM Status Word 32D MW VA4S
Disable Slave Comm.. YA Y37 vAOST4
Slave 1 H2-EBC Bhemet addeuE0e200 0 Depen ;. NORE that the 205/405 analog 1/0
Slave 17510t 0 16 Discrete Input MO XIT V4016 f _hit Ri
Slave 17510t 1 8 Discrete Dutput ¥I0 Y3 V0SS / channels are listed as 16-bit Binary
Slave 17510t 2 4 Word Input V2000 vaoos 16-bit Binary: i i
B e T e consecutive data registers (1 word) and
Slave 2 TIHEBC hotsvaplauto) Ethemet Address|00 EO0 62 40 06 34 i
Slave 2/5lot 1 8 Discrete Input HIO  HIT VDAY t!le Termmalur a'!aI'Jg 1/0 channels ?I‘e
Slave 2/5lot 2 8 DoubleWord Dutput V2102 2121 32:bit Binary: listed as 32-hit Bmary non-consecutive
8 Discrete Dutput Y3 Y3 V40515 .
Slave 2/Slot 3 8 Double Word Input Va4 va0zz 32:bit Binary: data registers (Douhle Wurd).
4 Double Word Dulput V2122 V2131 32 bit Binary:
8 Discrete Dutput Y30 Y347 V4516 ‘
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Reserved PLC Memory for ERM
The first two words of memory in the Discrete Input table is used for ERM/slave status
information, and the first word of memory in the Discrete Output table is for Disable Slave
Command bits. The default memory addresses DLX300/X300 and DLY300/Y300 are used
in this example.
Do-more DirectLOGIC
Slave Status Bits Slave Status Bits
MSB LSB :
Stave 16 CLTTTTT T T T T Stave 1 The Slave Status Bits can MSB V40414 LSB
DLX DLX be monitored to detect if 2 slave 16 LTI T I I TTTTITTTTT]Slave 1
3 3 slave is in error. X X
1 0 3 3
7 0 1 0
7 0
ERM Status Word The ERM Status Word ERM Status Word
contains the ERM error
T code and Status Bits (see S NnEER NS NNARE]
DLX DLX DLX the following description X XX X
3 33 3 and Error Codes in 3 33 3
S = : ~ Appendix B). Bit 8 S 32 :
\ /\ / indicates that the ERM is \ /\ /
Status Bits  Error Code disabling a slave. Status Bits  Error Code
The Disable Slave Bits can
Disable Slave Bits be used to disable a slave Disable Slave Bits
MSB LSB from communicating with MSB V40514 LSB
Slave 16 LLLTTTTTTTTTTTTT] Slave 1 H ITTTTTTTITITTITTI ]
ave 16 == oryoave the' ERM module.' BitON (o5 y Slave 1
3 3 = disable that specific slave. 3 3
17 8 RESET = re-enable the 17 8

specific slave.

ERM Status Word / Reset Slave Code
The ERM Status Word contains the current ERM Error Code in the Least Significant Byte
and the Status Bits in the Most Significant Byte. When using the Slave Disable Bits, the
ERM must recognize the request to disable a slave before attempting to re—enable that slave.
This closed loop feedback is necessary due to the asynchronous scans of the ERM and PLC.
X330 (DLX330 for Do-more) is the only feedback bit for ALL slave disabling bits (Y300 —
Y317 or DLY300 - DLY317). Either disable multiple slaves all on the same scan or serialize
the disable process by using ladder logic interlocks.

Use the following ladder logic code to manually reset a slave. For example, use this resetting
method when “Hot Swapping” a Terminator I/O module on a slave that is set up to be
manually reset using ladder logic. The default for the Terminator EBC is automatic rescan
after “Hot Swapping” and I/0O module.
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Direct SOFT
€200 co
{ } ( PD ) Event occurs to reset Slave 1
co Y300

{ } ( ser ) Disable Slave 1

Y300
\‘(30‘? T33T ( Wait to re—enable Slave 1 until X330 (ERM
| ] || \ RST ) Disable Request Bit) is ON.

Do-more Designer

Cz200
L

— (> PD— Leading Edge One-Shat
¥ Tree b Event occurs to reset Slave 1
co DLY300
=l { ser ) Disable Slave 1
DIY300  DLX330 BLY300 Wait to re—enable Slave 1 until DLX330 (ERM
¥ 1 ¥ 1 RST Disable Request Bit) is ON.

Saving ERM Configuration to Disk

The ERM configuration can be saved to disk as an ERM Workbench File (*.erm). The Save
command allows you to specify a name and location for the configuration. See File>Save.

Clear ERM Configuration

The Clear ERM command allows you to clear the existing configuration from an ERM
module. This function is useful when changing the ERM network configuration or
experiencing configuration difficulties. See File>Clear ERM.

Printing/Exporting the ERM Configuration

The ERM Configuration can be printed or exported as a text(.txt) or comma separated
variable(.csv) file. The ERM Configuration can be sorted by either the Slave/Base/Slot
Address or the PLC Memory Address. The ERM/Slave Status can also be included with the
print or export. See File>Print/Export.
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